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Certification Information

CE Declaration of Conformity

FISO Technologies Inc., located at 500, Saint-Jean-Baptiste Ave., Suite 195, Quebec, QC, Canada

G2E 5R9
Declares under its sole responsibility, that the following products:
Product description: evolution chassis for FPI modules
Model number(s): EVO-SD-2
EVO-SD-4
EVO-EXP-6
Product category : Electrical equipment for measurement, control, and laboratory use

To which this declaration relates, is in conformity with the following standard:

o EN 61326: 1997 +A1:1998,+A2:2001, +A3:2003

In accordance with the provisions of the following Council Directives:

 Electromagnetic Compatibility (EMC) Directive 89/336/EEC,
e As amended by 92/31/EEC and 93/68/EEC

Supplementary information:

This device complies with Part 15 of FCC rules. Operation is subject to the following two conditions: (1) this device
may not cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation.

I, the undersigned, hereby declare that the equipment specified above conforms to the listed directives and
standards.

o=

ederic Borne

Director, Research & Developement

FISO Technologies Inc.

500 Saint-Jean-Baptiste Ave.

Suite195

Quebec (Quebec) G2E 5R9 Canada

Phone: 418-688-8065 Fax: 418-688-8067
E-mail; frederic.borne@fiso.com

Issued in: Quebec, QC, Canada Date: Friday, January 11, 2008
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Safety Information

Safety Conventions

Before using the product described in this manual, you should understand the following conventions:

DANGER Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury. Do not
proceed unless you understand and meet the required conditions.

WARNING Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. Do not
proceed unless you understand and meet the required conditions.

CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in component damage. Do not
proceed unless you understand and meet the required conditions.

IMPORTANT Refers to information about this product you should not overlook.

Module Safety Information

The level of radiation emitted from the module and through the sensor is below the level known to cause eye
injury through accidental short-term exposure. However, avoid prolonged exposure to light emitted from the
fiber and do not stare directly at a light beam, visible or not.

The following safety instructions must be observed whenever the evolution Chassis is operated. Failure to
comply with any of these instructions or with any precaution or warning contained in the evolution Chassis
user guide is in direct violation of the standards of design, manufacture and intended uses of the evolution
Chassis. FISO assumes no liability for the customer failure to comply with these safety requirements. THIS
PRODUCT IS NOT DESIGNED FOR USE IN LIFE SUPPORT OR CRITICAL APPLICATIONS.

In no case will FISO be liable to the buyer, or to any third parties, for any consequential damage or indirect
damage which is caused by product failure, malfunction, or any other problem.

When using any electrical appliance, basic safety precautions should be followed, including the following:

» FISO recommends using the power supply delivered with your evolution Chassis and verifying that the
voltage specifications indicated on the power supply are compatible with the AC voltage and frequency
delivered at the power outlet.

> Do not operate in wet/damp conditions.

» Do not expose to outdoor conditions. Install the unit in a protective enclosure.
» Do not operate in an explosive atmosphere.

» Keep product surfaces clean and dry.

WARNING

This equipment must be used as specified or the protection provided by the equipment may be compromised.
You must use this product in a normal mode and should not deviate from the written instructions provided.

CAUTION

There are no user serviceable parts inside the evolution Chassis, other than the ones specified in the
Maintenance section. Adjusting parts inside the unit can affect instrument performance. If you adjust parts,
you will need to verify the equipment for good performance. Refer servicing of any other parts to qualified
personnel.

a
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evolution Chassis Overview

FISO manufactures the evolution Chassis. Its footprint, communication capabilities and speed make
it the ideal tool for laboratory and in site test environments. The evolution Chassis can house
different module types with different channel capabilities to combine results from a single
acquisition source.

The evolution Chassis comes in different models to answer different test needs:

P The EVO-SD-2 is a compact, stand-alone chassis that can house up to two modules.
P The EVO-SD-5 is a compact, stand-alone chassis that can house up to five modules.
» The EVO-RM is a rackmount chassis unit that can house up to eight modules.

To configure a complete chassis, a series of modules are available. Each module is described
separately in its respective user guide.

Your brand new evolution Chassis comes ready to use. This user guide describes the Chassis main
characteristics.

The evolution chassis have a different number of module slots, depending on the model:

» The EVO-SD-2 has two module slots.
» The EVO-SD-5 has five module slots.
P The EVO-RM has eight module slots.

MODULE SLOT

Figure 1: evolution chassis
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Front Panel

All evolution Chassis units are composed of the same basic frame elements. Module capacities,

communication ports, and overall width specifications differ from one model to the other. The
following images show the basic differences between the units.

MODULES
LED

POWER ON/OFF
BUTTON

s /

COMMUNICATION
INTERFACE

=
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o
L
LS

Figure 2: EVO-SD-2 front view
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Figure 3: EVO-SD-5 front view
MODULES
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UsB - A - B B B- 8- 8- &
COMMUNICATION
INTERFACE

Figure 4: EVO-RM front view
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The power on/off button is located near the top left corner of the front panel. It is a rocking switch.
When the top of the button is pushed in, the unit is powered on. To turn the unit off, press in the
bottom half of the button.

USB communication interface is available on all chassis. This interface allows communication with the
computer.

The power source input connector is located under the I-EVO on all units.

Modules

We have different kind of modules.

L] L L A

== . = S e
R | e | FP-HERO FPHHEME || EPC-HR

= () o) *@ ® [+O© |
" (%] | =10 = o = L =
:l""‘" | ks &E&@i‘ A [
'JQ_»—,: — = —— ey 1 ,J‘ggv
Figure 5: FPI- Figure 6: FPI- Figure 7: FPI- Figure 8: FPI- Figure 9: SPC-
HR module HS module HERO module HS/HE module HR module

Getting started with your evolution Chassis

Unpacking and Inspection

The evolution Chassis is packaged in a way that provides maximum protection during shipment. If
the outside of the shipping carton is damaged, notify your receiving department immediately. Your
receiving department may want to notify the carrier.

If the shipping case is not damaged, carefully remove and identify all of the components listed below.
Contact FISO or your local representative if any of the components are missing. We recommend you
save the shipping case for future storage or transportation.

The SD-2, SD-5 and RM evolution Chassis package should include the following components:

> evolution Chassis unit

i-evo module

Power supply adaptor and cord

USB interface cable

Module removal tool

User guide

CD containing software, driver and manual (PDF)

yYvYyYvy vyvyy
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Inserting and Removing Modules
evolution Chassis are compatible with all evolution modules.

During these procedures, be sure to turn-off the power of your chassis and to close the evolution
software.

To insert a module in a module slot:
1. Tilt the module backwards and hang the top back side on the back plate of the Chassis.
2. Align the module with the backplane rail connector.

3. Push the bottom of the module back until a clipping sound is heard.

Figure 10: Inserting Module

To remove a module from a module slot:
1. Insert the provided module removal tool in the module clip slot.
2. Tilt the tool upwards to pull the clip downwards and release the module.

3. Remove the module by tilting the top backwards and pull it out of the slot.

;
S

Figure 11: Removing Module
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Figure 12: Removing Module

Connecting the Interfaces

Before proceeding with product setup and use, read the safety information and instructions.

WARNING

To avoid damaging the unit, make sure that the power fed into the power port complies with
technical specifications power input range. No other voltage level or range is accepted.

The power supply adaptor is provided with the unit. Connect the power supply to the unit power
input connector, located under the I-EVO, according to the figure below.

SHENIENSN il

Figure 13: Connect the power supply
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CAUTION

Use care in handling fiber optic connectors. Always clean the fiber end prior to insertion into the
connector for optimum performance and to avoid measurement errors. For details on connector
handling and maintenance, please refer to section Handling the Sensors.

To Connect the Sensors to the Unit:

1. Align the connector key with the slot on the mating sleeve.

2. Slide the connector into the sleeve until you hear a clicking sound.

Figure 14: SCAIl-type 1 and SCAI-type 2
SMA-type and ST-type mating sleeves and connectors

Powering Up the Unit

1. Install the software on your computer.

2. Make sure that power is off when connecting the power supply to the unit.

3. Make sure that all the necessary modules are properly connected to the chassis.

4. Connect the USB cable to the computer and your chassis

5. Attach the line cord to a power source. Use the power supply provided with the unit.

6. Turn the power on to power up the unit using the ON/OFF switch on the front panel.
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evolution software

Software installation

Insert the evolution CD-ROM into your CD-ROM drive. If auto run does not start, open Windows
Explorer to view the CD-ROM's contents and double-click on setup.exe. The InstallShield wizard will
automatically start. Click Next a couple of time following the instructions to proceed with the

installation.

y Fiso Evolution - InstaliShield Wizard

InstalShield

8l Fiso Evolution - InstallShield Wizard ==

‘Welcome to the InstallShield Wizard for Fiso
Evolution

The Installshield(R) Wizard wil install Fiso Evalution on your
computer. To continue, cick Next.

WARNING: This program is protected by copyright law and
international treaties.

[ <Bak | Hexts [ cancel ]

#4] Fiso Evolution - InstallShield Wizard

Customer Information

Please enter your information.

User Name:
=

Qrgaization:

Install this appiication for:
© anyone who uses this computer (all users)
) Only for me (user)

Installshield

[ <Back [ next»

] [ cancel

8] Fiso Evolution - InstallShield Wizard =

Destination Folder A 4
Click Next to nstal o this foder, or cick Change to instal to 2 different o —

G Install Fiso Evolution to:
C:\Program Files (+86)FISO Technologies\

InstalShield

[ <Bad [ HNext> [ cancel

1§/ Fiso Evolution - InstallShield Wizard

[

Ready to Install the Program
The wizard is ready to begin installation.

exit the wizare

Current Settings:

1f you want to review or change any of your installation settings, ciick Back. Click Cancel to

Setup Type:
Typical

Destination Folder:
C:\Program Files (x86) \FISO Technologies\

User Information:
Name: user

Company:

InstalShield

[ <gak [Tl T [ cance

18! Fiso Evolution - InstallShield Wizard — éj

Installing Fiso Evolution 4 ‘
The program features you selected are being installed. -

] Plesse wait while the InstaliShield Wizard installs Fiso Evolution. This may
5 tokeseverd minutes.

Status

InstaliShild

N

A black window is prompt at the end of the procedure, let it proceed, it installs the platform drivers.

When the installation is over, click Finish to exit the Wizard.
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EJ Fiso Evolution - InstaliShield Wizard

InstaliShield Wizard Completed
“d

‘The InstaliShield Wizard has successfuly installed Fiso
Evolution. Click Finish to exit the wizard.

7] Launch the program

)

Driver installation

For newer platform (I-Evo), drivers are located in the “Drivers\I-Evo” folder on the CD. Run the CDM

Setup.exe.

For older platform (USB400), drivers are located in the “Drivers\USB400” folder on the CD. Select
your operating system folder (Windows Xp, Vista or 7 and 32 or 64 bits), then run Dplnst32.exe or

Dplnst64.exe.

Accessing the program

The program installation adds a shortcut to the desktop, so it can easily be launch with the Evolution
desktop shortcut. The program shortcut should also be found in the installed program list, under

FISO Technologies. The complete access menu is:

Start » All Programs » FISO Technologies » Evolution » Evolution
A splash screen is showed when the program is initializing.

FISQ Technologies
Evolution
a‘, Evolution

Evolution

Please wait while system is initializing...
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Software overview

evolution is the operating and data acquisition software for FISO evolution chassis. It can
communicate with all type of Evo module.

Main screen

/ v
.

e

A Evolution

System Ccmﬁgur*n About

Refresh devices: (2

= [ f Chassis 1 Monitor | Acquistion |
-0 []] 102P1091-FPHHR2
/ g; Channel selection ] Mode Module CH Sensor Current value
Add — .
. 1 =] [: 10ZP1091 1 |MBC0027B | 14,541 psi
Modules List
Measurement mods
Diagnostic
Display refresh rate

Menu and toolbar

The System P Quit menu closes the application. The Configuration menu gives access to all the
configuration windows and the About menu shows the software version. The toolbar button gives
quick access to refresh the system devices communication.

A Evolution A Evolution Refresh devices: o5

Systern | Configuration  About piieqal] | Configuration | R&bout
. - System...
Quit ) i
Dﬁﬂ Selected module...

Configured sensors list...

Default software acquisition rates

Latency timeouts
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Module list

User Guide

Located on the left side of the main screen, the module list shows all the modules and channels

configured.

Elzm Chassis 1
ElD il 09ZP1036 - FPI-RI-2
O o

Monitor and Acquisition tabs

The monitor tab shows current channel reading in a tabular view, and the acquisition tab is used to

start a chart / file acquisition.

| Maode Module CH Sensor

Dhagreste
Channel rfomaton |

Desplay refresh e

Current value

b~ 10zP1091 1 MBCO027B 14,581 psi

Mot Acausecn

Sesan

1w
|

s
W
! wns
un
I 1", m

uv)

vn.nu,

7 Ads Scale ) Lagene
SCROUL_LEFT -

- Mrwnm
8 duy 200030 1
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Quick steps

1. Connect evolution chassis with a USB cable to the PC. Power on the platform. Launch the

evolution software.
2. Configure your system.
Open System configuration window via menu Configuration » System.

evolution

°
e Click Auto-Detect. Transfer detected modules to selected modules.
e Reorder modules to reflect the physical order on your chassis.
e Close the window.
r‘ Evolution M System Configuration &J
List of port: » COM2 - 88X
Systern | Configuration | About Detected modl Setoctod moci
Refreshd|  System. = —
Selected module... iz 2
Configured sensors list... 2
Default software acquisition rates
Latency timeouts
1
A System Configuration Iﬂ‘
List of port: ~ COM2 A~ R
Detected modules Selected modules
e COM2 E|- Enter name
087P 1036 - FPI-RI2
11ZP1049 - FPIHR 2
3
4
3. Define acquisition rates.
e Open menu Configuration » Default software acquisition rates.
e Use slider(s) to define default values.
e (Close window.
r‘ Eralrar 'Defau\t software acquisition rates = i&‘
System | Configuration | About Elzdiand
125 Hz
Refresh d System... N -
Selected module...
Configured sensors list... Bms
Default software acquisition rates

Latency timeouts
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4. Configure channels / sensors information.

e Double click on module in the left tree.

e Click on each channel row to configure channel and sensor information.

e (Close the windows.

User Guide

System  Configuration

Refresh devices: 24

=-fif Chassis 1
of
0

02
n 11ZP1045 - FPI-HR-2
m
02

I

About

A Configuration - Module 097P1036
Module
Serial number: 03ZP1036 Connector type: SC/APC
Model: FPI-RI-2 Fiber type: 62.5/125
Caliraton dete:  2010-01-13 Controller versen: 2140
Bosverson: o version el 1111
Configuration
Low pass ‘Software acquistion
Channel e ency (Ha) rete (Ha) S il
1 1 125 H000000( AU
2 1 125 00000 AU

Click on channel row to configurs a channel

Refresh

- 1
A Configuration - Channel 1 ==
Software acquistion rate Low pass fiter
125 Hz
<[ ' Ferer be
2ms
Sensor Analog output
Serial number :  XO000C Type: Voltage
Pherameran - Custon Fefrhrete 125 He
Min Max
Unit - |ALU, v [ Sselectfromist | Physical value 20,000 AU 140,000 AU
Anslog value © 00 v 50 Vv
5. Monitor and set up channels.
e Add channels to the monitoring window.
e Configure measurement modes when needed.
[ e
PR
System  Configuration  About ::_;m Mode e Madle g g1
v b 097P1036 1
Refresh devices: 2 o Remve . & cazro3s| 2
=+ fifil Chassis 1 Moniter | Acquisition [r———
: 09ZP1036 - FPIRI-2 Sickte
i 1] Channel selection Mg
1
Add —
11ZF1049 - FPHHR-2 2 2 sate
1 0z Disgrostic
Channel infemation
Desplay refresh rate:
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6. Start an acquisition
e Configure acquisition parameters.
e Click Start.

evolution

Maonitor | Acquisition

gaba

Acquisition
13 050

13 040
13 030
13 020
13 010
13 000
12 990
12 980
12970

Measurement

1 2 3 4 5 [ 7 8 L] 10 11
Time (sec.)

v| 09ZP1036 - Channel 1 [ AU, ) [v]

Mode Auto Scale Legend

SCROLL_LEFT - Mai
admum [ Symbol

Time
[T Annotation

o Minimum
Dday 000030 3 (4]

Live graph [T Savetofile

Working folder. [[] Save statuses

Comment:
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Configuring system parameters

User Guide

To configure your system, use the menu Configuration » System...

r
A Evolution

System | Configuration | About

Refresh d| System...

Selected module...
Configured sensors list..,

Default software acquisition rates

Latency timeouts

4 System Configuration

List of port: ~ COML - @4 X

Detected modules Selected modules

Add Chassi

Move dow

o
a @
2|5 }
alls H

a2 }
glls| |3 a

List of ports

The list of port may contain different type of port: Serial (Com port), USB (I-Evo serial number). Use
the arrow and check the type of port to display on the list (normally both Serial and USB are
checked). Use the Refresh port list button to refresh the list and detect newly added ports.

Modules detection

For an easy detection of your system, use the Auto-Detect button. It will scan the list of port to
detect all the modules connected to the PC. If you know the name of the port of the platform you
want to add, you can also choose it from the list of port and click Add port (+). If your modules are
not detected, be sure the platform drivers are installed, the platform is power on, connected to the
PC with USB cable and detected by the operating system. Use the Show error(s) button to check for

possible error on port after detection.

Select the type(s) of port to display on the list.
Use Refresh port list to refresh the list.

A System Configuration

List of port: +| COML Bl X
ZI Serial Selected modules
ZI USB port: | | |

To add a port, select a port from list and click
Add port (+).

A System Configuration
List of port: - | [@A0H ‘v|§ )(
Detected modules

Se\ec‘ted&
| | ‘ Add port

List of detected modules grouped by port
name.

To release a port, select it in the Detected

modules list and click Remove port (X).

==

A System Configuration

]

4 System Configuration

List of port: ~ |80 -l X

Detected modules:

= COM2
- 10ZP1091 - FPI-HR-2

Selected modules

Add Chassi:

|

E T
g
o @ ij &
ol NEAN 3
§ g
5 g

List of port: + COM2 - B -LP

Detected modules Selected modylee
=i com2 Remove Port
1021081 - FPIHR2

Add Chassis

o
= Ey
2|7
AlalEE
alla||d 4
EE 3
gils| s
3 4
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Chassis configuration

When all the connected modules are detected, you need to configure your platform’s tree on the

right side, the Selected modules list.
From the Detected modules, double-click on the port node or a module node to add the module(s)

to a chassis on the Selected modules list. You can also use the arrows buttons to move modules
between lists.

& System Configuration == A System Configuration =)
List of port ~ COM2 B NI Listof port: + COM2 A=A
Detected modules Selected modules Detected modules Selected modules
©-CoM2 Erter name -~ COM2 = {Chasss 1| Enter name
- 10ZP1091 - FPI-HR-2 =-10ZP1091 - FPI-HR-2
W |
| |
Auto Detect Show enor) | [ ok ] Ao Detect Show erors) |

Use Add Chassis or Remove to configure chassis list. Rename chassis if you like. Use Move up, Move
down to reorder modules in the chassis (platform) to reflect modules order on the platform or as you
wish. Once your configuration is completed, click OK. Your configuration will now be shown in the

main window.
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Configuring module

Now that your modules are shown in the system

configuration window.

User Guide

tree, you can configure them using the Module

Select a module in the list and double click on
it to show module configuration

Or select a module or channel node in the list
and click menu Configuration » Selected

Configuration

About

System...

Selected module...

Configured sensors list...

Default software acquisition rates

Latency timeouts

module...
F r‘ Evelution
A Evolution
System
Systern  Configuration  About Refrech d
Refresh devices: 24
= Chassis 1
EREN | 102P 1091 - FPI-HR-2
01
02

r 5
A Configuration - Module 10ZP1091 [
Module
Serial number: 10ZP1091 Connector type: SC/APC
Model: FPI-HR-2 Fiber type: £2.5/125
Calibration date:  2010-11-22 09:00 Controller version: 2125
Bios version: Mo wersion Firmware version:  2.0.0.18
Configuration
Low pass Software acquisition §
Channel frequency (Hz) rte {Hz) Sensor Unit
1 125 125 test AL
2 125 125 test AL
Click on channel row to configure a channel
Reset Refresh ] [ Close

The Module section on top contains embedded module information such as serial number, model
and software/hardware versions. The Configuration section provides access to the channel

configuration parameters.

To refresh channels configuration and read newly connected smart sensors use the Refresh button.



FISO

To reset all channel settings, you can use the Reset button.

evolution

A Warning!

e

- Filter

- Unit

/\ WARNING /A\

- Analog output
- Sensor offset
- Gage factor

All the following parameters will be reset

- Atmospheric pressure compensation
will be tumed on f available on the unit

Proceed H Cancel

Configuring channel

To configure a channel, click on the channel row in the bottom grid of the module window, to show

the channel configuration window:

r 3
A Configuration - Channel 1 &J
Software acquisttion rate Low pass fitter
125 Hz
b D Frequency 125 » | Hz
Sms
Sensor Analog output
Serial number :  test Type: Voltage
Refresh rate 125 Hz
Phenomenon :  Custom
Min Max
Urit ;| AL 'J { Select from list I Physical value : -20,000 A.U. 140,000 AU
Analog value : 00 v 50 v

Software acquisition rate

Use the slider to set the frequency or period of the software data acquisition. Note that this is not

the module’s internal frequency, but the acquisition rate of the evolution software. The analog
output is always at the maximum rate.

Low pass filter

Low-pass filters provide a smoother form of a signal, removing the short-term fluctuations, and
leaving the longer-term trend. Defining a lower frequency than the module’s frequency will therefore

reduce the noise in the reading.

4
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Current sensor serial number, phenomenon and physical unit is shown. Use the Unit dropdown to

define the physical unit.

To show more information of the current sensor configured in the channel, use Show current.

A Sensor Configuration ﬁ
Sensor
Serial number : |MBCO027B Type of fiber ; |62.5/125 Gradiant Glass
Medel : | FOP-M26( Type of connector : | SC/APC
Calibration date : 2012-02-02
Phenomenon : | Pressure
it : | psi Signal polarity : | Negative

Algorithm type : | Polynomial regression

Center : 17034

Label Value

b -0,01135689
c 3.140611E-D6
d -1,558842E-09
e 0

Every time you connect a new smart sensor on the module, sensor information from the smart
connector is loaded into the channel configuration. The channel information can also be overridden

by a user defined sensor.

To refresh current channel sensor information with the smart sensor values, use the Read smart

sensor button.

With standard sensors (without intelligence) or to customize the sensor information, use the Select
from list button to show and edit the list of sensors.
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The list is also accessible via the menu Configuration » Configured sensors list...
Bl 4 Fiso.Controls.Sensorlist
System | Cenfiguration | About
Refresh d System...
Selected module...
Configured sensors list... |
Default software acquisition rates
Latency timeouts
A FisoControls SensorList - C\ProgramData\Sensorlistdat Ié]
File
=
Serial number : test Type of fiber : [Unknown ']
Model : Type of connector : [Unknown ']
Calibration date : 2012-04-20 [k
Center :
Label Value
2 [
b 1
c 0
d 0
e 0
Remove ][ Add new [ fesos ] [ Aonly ]

Using the File menu, you can Open any list to load it, Save list modifications, or save a copy (Save

as...).

To add a new sensor to the list, click Add new.
Fill up serial number, model, type of fiber, type of connector and calibration date, which are
informative information only.

Type of fiber Type of connector
Unknown Unknown
50/125 Gradient Glass SC/APC
62.5/125 Gradient Glass SC/PC
100/400 Gradient Glass ST/PC
200/220 Step Glass FC/APC
FC/PC

4
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Define sensor phenomenon, then select the coefficients unit.

Phenomenon
Pressure Length Force Angle Acceleration
psi mm N ° m/s?
bar in dyn rad g
mmHg um gf grad ft/s?
mmH20 mil ozf min
kPa nm Ibf sec
atm m am
E torr
Temperature Strain Mass Current Magnetic
°F pe g mA T
°C ppm oz A G
K % Ibm C/s gamma
Refraction Humidity Custom Unknown
RIU %RH A.U. unknown

Select the algorithm type.

Algorithm type

Unknown : invalid, do not use.
Polynomial regression : polynomial fit (see definition below)
Sqrt. poly. regression : square polynomial fit (rarely used)

7 digits format : Fiso gauge factor

Polynomial regression

Phenomenon - [Fraseae_« For polynomial regression algorithm type, enter center and
Unt - [psi = coefficients (a,b,c,d,e) values of the polynomial fit used to convert
Algorthm type : | Polynonial egression = internal reading (L in nm) to physical phenomenon reading (P in unit).
Center : 16822 1 2 3
— s P=a + b*(L-—center) + c*(L—center)” + d* (L—center)” + e * (L-
E 14913 center) N
b -0,005502734
c 4.340757E-06
d -1,471404E09
e 0 If centerislefttoO:

P=a +bL ' +cL®>+dL>+eL"

4
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7 digits format

Pheromenan For 7 digits format, fill up the gauge factor provided to you by Fiso, in

. o"_n
bm:fc o the “a” value.

Center

Label Value

Fill up the coefficient values.

Signal polarity must be left to Negative, choose Positive for HERO sensors.

When your sensor configuration is done, click Apply then OK to close the window. The selected
sensor will be set in the channel configuration.

To delete a sensor from the list, select it serial number in the list and press the Remove button.

Analog output

If your module is equipped with an analog output, you can define the range of value in the physical
unit corresponding to the analog output value. The formula to evaluate physical value based on the
analog value is equivalent to the linear equation: y = mx + b, where m = AY/AX.

Analog output
Type: Voltage
Refresh rate 125 Hz
Min Mz
Physical value : 200000, T 140,000 *C
Analog value : 0o v R0V

150 /
50
O T T T T 1
( 1 2 3 4 5
.50

In this example, with a temperature sensor, 0 Volt on the analog output will be corresponding to -20
degree, and a 5 Volt reading on the analog output equal to 140 degree.

4
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m = AY/AX = (PhysicalMax — PhysicalMin) / (AnalogMax — AnalogMin) =160 /5 =32
b =y-mx=140-32*%5=-20

Y=mx+b =32x-20

So for example, for a 3 V reading, temperature would be : 32*3 — 20 =76 degree.

Default acquisition rates

To configure the software acquisition rate of multiple channels at once, remove channels from the
monitoring window then use menu Configuration » Default software acquisition rates. Set the
default rates, and click OK. All channels that are not in monitoring will be updated with these values.

Monitor | Acquisition

Channel selection Mode Module CH
Add —> \«i 10zP1091 | 1

e \1\ 10zP1091 2

~
Default software acquisition rates = [

125 Hz channel

,
A Evolution

System | Cenfiguration | About

125 H:
Refresh d System.. z
<

Selected module...
Configured sensors list...

Default software acquisition rates

Latency timeouts
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Refreshing system

A Evolution

Systemn  Configuration  About
Refresh devices :

SR 1| Chassis 1
+[C]jg| 10ZP1091 - FPI-HR-2

When a module is in error or not detected by the software, the module node is red. Use the Refresh
devices button in the toolbar to reinitialize communication with the system. If the module is still in
error, reboot platform, and check error on the system configuration window.

Once all the channels for all the modules have been configured, you may proceed with the
monitoring and acquisition.
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The monitoring tab collects channels data at regular interval and displays them in a tabular view.

A Evolution

EE)

System  Configuration  About

Refresh devices: 2

= LI Chassis
=-_|[f| 102P1091-FPIHR-2
- o
- 02

Monitor | Acquistion |

Channel selection

Add —>
<— Remove

Measurement modes

Absolute
Nuling

Setto

Diagnostic

Channel information

Display refresh rate

g

1 Mode
\'\_/\ 107P1091 | 1 |MBC002 .

Module CH Sensor

Current value

14,705 psi

Channel selection

To add channel(s) to the monitoring and acquisition window, select the desired channels with their
check box from the Chassis tree on the left, and click the Add=> button from the monitor tab. To
remove unwanted channels, use the checkbox from the monitoring grid and click the € Remove

button.

Measurement modes

Absolute button: sets selected channels to absolute reading (no offset).

Nulling button: sets selected channels reading to 0.
Set to button: sets selected channels reading to the provided value (text box below).

Mode

Absolute measurements

Offset measurements (nulling and set to)
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Diagnostics
Channel information button: Show selected channel(s) diagnostics.

F r ~
Channel information u Channels information E@g
Module : 10ZP1051
Channel : 1 Channels information
Sensor : MBCO0278
C=pol i G0 Module Channel Sensor Lamp PWM Modulation Position CCD Signal

Modulation : 70%

Position - 17076.31 nm 102P1091  CHI MBCO0Z7B 3 7 1707681 nm | 3.12V
CCD Sgnal = 262V | CZ2CTI TN N P L TSN T

Display refresh rate

Display refresh rate

U—

Use slider to increase or decrease monitoring speed.
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Acquisition

The acquisition tab collects the device data in real time and displays them graphically and / or saves
them to text files. To add channels to the acquisition, you must add them via the Monitor tab. Be
sure to also configure the desired software acquisition rate on each channel (with the channel
configuration or the Default acquisition rates windows).

r ~
A Evolution =NACE X
System  Configuration  About
Refresh devices: 2
B-D‘“_m Chassis 1 ‘ Mnn'rmrl Acquisition |
=[] 122P1013- FRIHR2 -
il 2 genm
02 .
- Acquisition
TIf 12zP1014- FRIHR2 A
m
: 0 o =
£+ 122P1015 - FRIHR2 L
m £ o
LA W g
Bml W 127r1016 - FPIHR2 !
Q
Time (sec.)
v| 12ZP1013 - Channel 1 { *C ) [v| v| 12ZP1014 - Channel 1 { °C )
v| 12ZP1014 - Channel 2 { *C ) [v] 122P1015 - Channel 1 ( °C ) [v] 12ZP1015 - Channel 2 ( °C)
v| 12ZP1016 - Channel 1 { °C ) v/
Mode Auto Scale Legend
SCROLL_LEFT - Maimum  [1000,00
Time " — - Symbol
= inimum  |0,00
0day 000030 |5 Annotation
livegraph [C] Savetofie
Working folder: [ Save statuses
Commert:

Chart acquisition

When the Live graph option is checked, the real-time acquisition data will be plotted to the chart.
See the bottom legend for the list of channels colors. To hide a channel series from the chart,
uncheck the channel in the bottom legend, or remove it completely from the monitored channels in
the monitoring tab.

Before starting the acquisition, please set the chart Mode and Time (duration):
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Mode

evolution

e Scroll left, Scroll right: scrolls the chart to display the latest points for the time period.

e Loop: Rather than scrolling through the time scale, the time scale is fixed and value are

added in loop.

e Accumulation: accumulates data in the chart for the desired period of time and auto-Stop

the acquisition.

Time

Set the time duration displayed on the chart for the acquisition. The minimum value is: 1 second and
the maximum value vary depending of the number of channels and their software acquisition rate,
preventing too large amount data to be plotted. Use the Up Arrow to set it to maximum value.

Auto Scale

When the option is checked, the Y axis scale self adjusts according to the chart values. To define Y
axis scale manually, uncheck the Auto Scale option and set the Minimum and Maximum values.

A Evolution SRRCE X
System  Configuration  About
Refresh devices :
=0 il Chassis 1 Acquisition
o f]| 102P1091-FRIHRZ =
M oz g 8aE
o o2 Acquisition
14,735
14,73
14,725
2 14,72
£ 14,715
&
£ 17n
@ 14,705
= 14,7
14,695
14,69
05 1 15 2 25 3 35 4 4,5 55 6
Time (sec.)
v 10ZP1091 - Channel 1 ( psi)
Mode Adto Scale Legend
SCROLL_LEFT = Maxirusm TR
Time . = Symbol
- jnimum (0,00
Dday 000030 | Anotation
Live graph Savelofile
Browse... Save statuses

To start or stop a live chart acquisition, check the Live graph checkbox and use the Start/Stop

button.
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Symbol and Annotation

A Evolution = | )
System  Configuration  About
Refresh devices: £
M| =-Cfm Chassis 1 Acquisiion
=C1[ 102P1091 - FPI-HR2 O @nm
0o m
7 02 Acquisition [Time (sec) : 4,888
14,74 Measurement : 14,7083921432495
14,73
2 172
§
£wun
1 "
T o147
14,69
14,68
[ H 10 15
Time (sec.)
V] 10ZP1091 - Channel 1 { psi )
Mode Auto Scale Legend
SCROLL LEFT  ~ Maimum  [1000,00
Time = Symbol
| = Mirimum (0,00
Ddayo00030 [+ (] Annotation
Live graph ] Savetofile
ki foldr ] Sovestsses
Commert

Chart options

To Show/Hide the chart legend, use the Legend checkbox.

To Show/Hide the values, use the Symbol checkbox.

To Show/Hide the annotation window, use the Annotation checkbox.

To zoom in on the Chart, press the left mouse button at the top left hand corner of the area you wish
to zoom in on and, maintaining the mouse button pressed, drag out the rectangle to the bottom right
hand corner of the zoom area. Releasing the mouse button will force the Chart to redraw the area
selected. To undo the zoom, press the left mouse button anywhere on the Chart area and drag up
and left with the mouse button depressed. Releasing the button will force the Chart to redraw to the

originally defined Chart area.

To scroll the Chart across, press the right mouse button and, maintaining the mouse button pressed,
drag the mouse in the direction you wish to scroll the Chart. When you release the mouse button the
Chart will remain at the new location. To undo the scroll, press the left mouse button anywhere on
the Chart area and drag up and left with the mouse button depressed. Release the button and the
Chart will redraw to the originally defined Chart area.
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Use the Chart toolbar to print, copy or save the chart data to different file formats.

evolution

Manitor |

9 emdHA

button.

To save the chart as a picture, choose the file
format, define options, then use the Save

(@ TeeChart Export

Ficture | Native | Data | Theme |

Format:

as Bitmap

as Metafile

as PNG

as GIF

as TIFF

as VML (HTM)
as SVG (SVG)
as PDF

as PostScript
as XAML (WPF)

¢ Options | Size |

O Gray scale

- % Quality:

95

To save the chart as data, Select the Data tab,
define the serie(s) you want, select the file
format, define data to include and click the

Save button.

-
(3 TeeChart Export

[ESY I C)

| Picture [ Native | Data | Theme |

all)
Fomat 137P 1036 - Channel 1 (.
() Tez09ZP1036 - Channel 2 (|
11ZP1045 - Channel 1 (

(1 XN 11ZP1049 - Channel 2 | |
{7y HTML Table
(%) Excel

Include:
O Paint Index

[l Point Labels
[¥l Header

Coor | |

Save...

Close

| Copy | | Save... |

h—
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File acquisition

Check the Save to file option to save the acquisition data to files. Before starting a file acquisition,
select the folder where you want the files to be saved, using the Browse... button.

Data are stored in a folder identified with the date and time of the acquisition. Each data file contains
a series of .txt documents.

e The Acquisition file, which contains acquisition date, time and any comments that were
written in the Comment text box.

e One file for each channel used during the acquisition session. This file is identified with the
module serial number and channel number. It contains the module, channel and sensor
information and the data with timestamps. The Save statuses checkbox should only be
checked for troubleshooting, it adds a status column (valid, no signal, lost) to the data.

The acquisition can run simultaneously in the files and chart. But if you uncheck the Live graph
option, no data will be plotted to the chart and new options will become available to configure and
schedule the file acquisition:

A Evolution = | B )
System  Configuration  About
Refresh devices: &
= Chassis 1 Aequistion
=V [l 10ZP1091- FPIHR-2 P -
o @ abi
02 Acquisition
€
]
]
E Q
8
o
=
]
Time (sec.)
V| 10ZP1091 - Channel 1 ( psi) (¥
Run Duration Repeat End
@ immediatly () delay @ cortinuous @ none Auto stop date
2011-11-22 00:00:00 9 time | 0 day 00:00:01 % every |Dday 00:00:01 [&] =]
[ Live graph Save to file
Working folder DA\Evoldtion Logs [F] Save statuses
a
Commert:
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Scheduler

To show the file acquisition schedule, check the Save to file option and uncheck the Live graph
option.

Run

Immediately: start acquisition when you push Start.
Delay: start acquisition at the date and time you set.

Duration

Continuous: no time duration for the acquisition, stops when you click Stop.
Time: acquisition will last the time duration you set.

Repeat

None: no repetition of the acquisition.
Every: time between each Start Acquisition.

End

Auto stop date: The date when you want to stop the process (stop a continuous acquisition or stop a
repeated acquisition).

Timeouts

The menu Configuration » Latency timeouts opens a configuration window for the software
timeouts. On normal use, leave Serial and USB values to the default 0.6 s.

~ r N
4 Evolution Latency timeouts
System | Configuration | About
Refresh d System... Communication:
Selected module... Serial: 0.6 = 5
Configured sensors list...
Default software acquisition rates LISB: 0.6 ~ 8
Latency timeouts
Defaut || OK || Cancel
h
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Maintenance

Handling the Sensors
Read the following precautions prior to installing and when using sensors:

Avoid sharp bending radius in the fiber-optic cable (< 50 mm).

Avoid tension, pinch points or twisting of the fiber-optic cable.

Do not pull on fiber-optic cable to clear tangles; instead, carefully unwind.

Do not allow the fiber-optic connectors to drop or scrape on hard surfaces.

Keep the surface of the fiber-optic connector clean.

Always use protector caps on the fiber-optic connectors when sensors are disconnected from
the signal conditioner.

yYYyYyYVyYTVYYy

Cleaning a Fiber Optic Connector

To make good optical measurements, it is extremely important to clean the fiber-optic connector
before each connection. Dirt on the connector can degrade the reliability of the measurement and
cause permanent damage to the connector resulting in non-functional sensors.

Modern fiber-optic connectors rely on a glass-to-glass contact to reduce Fresnel reflections at the
connector interface. A dirty or damaged connector on the cable can damage the input connector.
Always use a good quality cable connector. If there is any question about the surface quality on the
tip of the cable connector, inspect it under a microscope for scratches or debris.

Some general recommendations:

» Never use a metal or other hard object for cleaning; it would scratch the ferrule.
» Do not apply index-matching gel or oils.
P+ Always keep connectors covered for protection when not in use.

To clean the end of the connector on the fiber-optic cable:

1. Deposit one drop of isopropyl alcohol on a lint-free wiping cloth.

Gently wipe the entire ferrule (and especially the end) in a straight-line motion.

3. Using a dry lint-free wiping cloth, gently wipe the same surfaces to ensure that the connector
and ferrule are perfectly dry.

4. Throw out wiping cloths after one use.

5. Assoon as the connector is clean, insert it in the panel or cover it for later use.

N

Cleaning Signal Conditioner Ports

It is equally important to make good optical connections and to clean the fiber-optic detector port
before each connection. Dirt on the detector can degrade the reliability of the measurement and
cause permanent damage to the connector resulting in an expensive repair.

To clean the connector on the fiber-optic detector port:

1. Moisten a cleaning swab with one drop of isopropyl alcohol.

2. Insert the cleaning tip into the connector using a slow clockwise rotating movement until it
reaches the ferrule inside.

3. Gently rotate the cleaning tip one full turn.

Continue to turn as you withdraw the cleaning tip.

5. Repeat steps 2 to 4, but this time, use a new dry cleaning swab.

b

4
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Replacing Parts

When handling optical fibers and fiber-optic connectors, follow the general recommendations
presented in this section.

There are no user serviceable parts inside the evolution Chassis, other than the ones specified in
the Maintenance section. Adjusting parts inside the unit can affect the accuracy of the instrument. If
you adjust parts, you will need to verify the accuracy of the measurements.

Troubleshooting

Solving Common Problems

The following troubleshooting guide was designed to help you solve technical problems. If you
conclude that the unit has to be returned for repairs, or if you need assistance, please contact FISO
Technical Support at support@fiso.com.

Symptom Possible cause Possible solution
LED no light No power Turn on the ON/OFF switch, located near the top left corner of the front panel.
LED no light Main power Try another power outlet.
LED no light Power supply Verify the power supply connection. If possible, try another 24 VDC power
supply (with the same polarity), or test the voltage of the power supply. If the
power supply is faulty, call FISO.

Table 1: Troubleshooting common problems

Depending on local parameters, the spreadsheet software may have some problems to interpret
correctly the column separator and the decimal separator. In that case, save your .csv file in .txt,
open the .txt file in the spreadsheet software and follow the instructions on the parameters’ screen
of the opened text file.

Contacting FISO Technical Support

To obtain after-sales service or technical support for this product, contact FISO at one of the
following numbers. Technical Support is available from Monday to Friday, from 8:00 a.m. to
5:00 p.m. (Eastern Time in North America).

FISO Technologies Inc. Telephone: (418) 688-8065

500, St-Jean-Baptiste Avenue, Suite 195 Fax: (418) 688-8067
Québec (Québec) G2E 5R9 E-mail: support@fiso.com
CANADA URL: http://www.fiso.com

To accelerate the process, please have information such as the name and the serial number of your
product as well as a description of your problem close at hand.

4
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Warranty
General Information

FISO (FISO) warrants this equipment against defects in material and workmanship for a period of one
year and its fiber optic transducers and sensors for ninety (90) days from the date of original
shipment. FISO also warrants that this equipment will meet applicable specifications under normal
use.

During the warranty period, FISO will, at its discretion, repair, replace, or issue credit for any
defective product, as well as recalibrate the product free of charge should the equipment need to be
repaired or if the original calibration is erroneous.

IMPORTANT

The warranty can become null and void if:

» The equipment has been tampered with, repaired, or worked upon by unauthorized
individuals or non-FISO personnel.

>  The warranty sticker has been removed.

> Case screws, other than those specified in this manual, have been removed.

»  The case has been opened, other than as explained in this manual.

> The equipment serial number has been altered, erased, or removed.

»  The equipment has been misused, neglected, or damaged by accident.
Liability

FISO shall not be liable for damages resulting from the use of the purchased product, nor shall be
responsible for any failure in the performance of other items to which the purchased product is
connected or the operation of any system of which the purchased product may be a part.

FISO shall not be liable for damages resulting from improper usage or unauthorized modification of
the product, its accompanying accessories and software.

Exclusions

FISO reserves the right to make changes in the design or construction of any of its products at any
time without incurring obligation to make any changes whatsoever on units purchased. Accessories,
including but not limited to fuses, pilot lamps, and batteries used with FISO products are not covered
by this warranty.

Certification

FISO certifies that this equipment has met its published specifications at the time of shipment from
the factory.

4
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Service and Repairs

FISO commits to provide product service and repair for five years following the date of purchase.

To send any equipment for service or repairs:
Call your local FISO products representative or FISO head office. Support personnel will determine if the
equipment requires service, repair, or calibration.

If the equipment must be returned to FISO or to a local distributor, support personnel will issue a Return
Merchandise Authorization (RMA) number, a detailed instruction sheet, and provide an address for return.

If the unit has an internal storage device, perform a data backup before sending the unit for repairs.

Pack the equipment in its original shipping material. Be sure to include a statement or report fully detailing the
defect and the conditions under which it was observed.

Return the equipment, prepaid, to the address given to you by support personnel. Be sure to write the RMA
number on the shipping slip. FISO will refuse and return any package that does not bear an RMA number.

Note: A test setup fee will apply to any returned unit that, after test, is found to meet the
applicable specifications. Likewise, a fee will apply if the only trouble found is related
to dirty connectors.

After repair, the equipment will be returned with a repair report. If the equipment is
not under warranty, the customer will be invoiced for the cost appearing on this
report. Return-to-customer shipping costs will only be paid by FISO for equipment
under warranty. Shipping insurance is at the customer’s expense.

Transportation

Maintain a temperature range within specifications when transporting the unit. Transportation
damage can occur from improper handling. The following steps are recommended to minimize the
possibility of damage:

B Pack the unit in its original packing material when shipping.
» Avoid high humidity or large temperature fluctuations.
» Keep the unit out of direct sunlight.

Avoid unnecessary shock and vibration.

FISO Customer Service

If you require service or need information about our products, contact your local representative or
FISO head office (contact details below).

FISO Technologies (head office) Telephone: (418) 688-8065
500 St-Jean-Baptiste Avenue, Suite 195 Fax: (418) 688-8067
Québec City (Quebec) G2E 5R9 Email: support@fiso.com
CANADA
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A. Technical Specifications

Chassis Specifications

evolution EVO-SD-2 | evolution EVO-SD-5 | evolution EVO-RM
Communication e USB e USB e USB
Datalog memory Computer Computer Computer
Number of slots 2 5 8
Power supply e 24 VDC e 24 VDC e 24 VDC
e 70 W e 70 W e 70 W

Table 2: Chassis specifications
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B. Refractive index transducers

The refractive index transducer is based on the variation of the optical Fabry-Perot cavity length that
results from the refractive index properties of the liquid. The liquid filled cavity length, hereinafter
called optical cavity length (L,picar), is given by the physical cavity length (Lpnysica) multiplied by the
refractive index of the liquid (njigui):

Loptical = nquuid o I—Physical

Since FISO signal conditioner has the capability to measure the absolute cavity length, there is no
need for probe calibration.

The user must first create a sensor.
Access the “Configured sensors list”. Simply click on the Configured sensors list button from the
Configuration pull-down menu.

", Evolution

System | Configuration | About
Refresh d System...
=2 []

= |:| Configured sensors list...

Default software acquisition rates

Click on “Add new” to add a sensor to the sensors list.
To configure the sensor:

1- For informative purpose only. Type the serial number as indicated on the sensor box. The
serial number will appear in the Sensor list.

2- Forinformative purpose only. Type the model as indicated on the sensor box.

3- Select the Refraction phenomenon.

4- Unit “RIU” is automatically displayed.

5- Value “1” for label b is also automatically displayed

6- For informative purpose select the type of fiber.

7- For informative purpose select the type of connector.

8- For refractive index sensor when the internal units increases the refractive index increases
so select “Positive” as signal polarity.

9- Click on Apply.

10- Click on OK.

4
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", Fiso.Controls.SensorList - C:\Documents and Settings\All Users\Application Data\SensorList.dat

File
SFO9102 Sensor
SFO5095 ) ) . p—— -
FRI-DEMO Serial number : [FRlevo | Typeoffiber: [625/125Gradant Glass v
FRl-evo
Model : |FR|-NP-CE | Type of connector - | SC/APC b |
Calibration date : | 3 janvier 2012 hd |
Phenomenon : | Refraction v
Urit | RIL V| Signal polarity :
Algorithm type : | Polynomial regression | » |
Label Value
b 1
c 0
d 0
e 0
Remave ” Add new [ TR ] [ Aooly l
[ QK ] [ Cancel l

Refractive index sensors may not have an intelligent connector, so on sensor connection the module
and channel does not get the information on sensor(s) that do not have an intelligent connector. So
the user must assign the sensor with no intelligent connector to the channel on which the sensor is
connected.

To assign a sensor with no intelligent connector to a specific channel, the user must drill down from
the chassis to the channel and assign a sensor to this channel

Double click on the module

: %, Evolution |:| |§| le
System  Configuraton  About

Refresh devices : &2
= [CIffmi Chassis 1 Monitor |}‘\cquis'rti0n
ER M) | 0sFP0050 - FPI-HR-2
O o1 Channel selection ] Mode Module CH Sensor Current value

O % Dpouple dlick

or click once on the module and from the Configuration menu, click on Selected module:

- ', Evolution
System | Configuration | About
Refresh d System...
H| Selected module. .. - quisition
= Configured sensors list...
Default software acquisition rates sslection | [1 Mode Module CH | Sensor Current value
— T Al =
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Now click anywhere on the channel line you want to configure.
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: , Configuration - Module 09FP0050

Module
Serial number: 0SFPO050 Connector type: SCAAPC
Madel: FPI-HR-2 Fiber type: 62.5/125
Calibration date:  2007-05-10 0900 Controller version:  2.1.1.0
Bios version: Na version Firmware version:  2.0.0.7
Conrfiguration
Low pass Software acquisition §
Channel frequency (Hz) rate (Hz) Sensor Unit
1 1 5 MBBO121L mmHg
2 1 5 MEBOO54D mmHg

Click on channel row to corfigure a channel

Fefresh l [ Close

Now click on Select from list.

: , Configuration - Channel 1

Software acquisition rate

B Hz
1 1 1 I-|I 1 1 1 1 1 1 1 1 1 1 1

€| >
— T Y

200 ms

Sensor

Serial number . MEED1Z1L
Phenomenon :  Pressure
Unit : [mmHg V| [ (Select from list ) l

Low pass filter

Analog output
Type: Voltage
Refresh rate : 125 Hz
Min
Physical value : -20,000| mmHg
Analog value : v

Max

y

Cloze

Choose the Refractive Index sensor in this example “FRI-evo” then click Apply and OK.
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", Fiso.Controls.SensorList - C:\Documents and Settings\All Users\Application Data\SensorList.dat

File
SFO9102 Sensor
SFO5095 ) ) . p—— -
FRI-DEMO Serial number : [FRlevo | Typeoffiber: [625/125Gradant Glass v
Model : |FR|-NP-CE | Type of connector - | SC/APC b |
Calibration date : | 3 janvier 2012 hd |
Phenomenon : | Refraction v |
Urit | RIL V| Signal polarity :
Algorithm type : | Polynomial regression | » |
Label Value
b 1
c 0
d 0
e 0
Remave ” Add new [ TR ] [ Aooly l
[ QK ] [ Cancel l

If your module has an analog output you may program the analog output respecting the minimum
and maximum values that your FPI module can read.

: s Configuration - Channel 1

Software acquisttion rate Low pass fiter

Fequency: |1 8|

Sensor Analog output

Seral number . FRleva Type: Voltage
. Refrash rate 125 Hz
Phenomenon :  Refraction
Min W&
Unit : | RIL v| [ Select from list ] Physical value RIU RIU

Cloge

Close the Channel configuration window
And close the Module configuration window
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. Configuration - Module 09FP0050

Click on channel row to corfigure a channel

Module
Serial number: 0SFPO050 Connector type: SC/APC
Model: FPI-HR-2 Fiber type: 62.5/125
Calibration date:  2007-05-10 09:00 Controller version:  2.1.1.0
Bios version: Mo version Firmware version:  2.0.0.7
Configuration
Low pass Software acquisition .
Channel frequency (Hz) rate (Hz) Sensor IInit
1 1 5 FRleva RIU
2 1 4] MEBDOE4D mmHg

| Refresh |

[ Close

In the Monitor window select and add the channel on which the refractive index is connected to the

Monitor display.

', Evolution

System  Configuration  About

Refresh devices :

= [Iffif Chassis 1

=[] [f| 0SFPO050-FPI-HR-2
v o
| 02

Monitor | Acquistion |

Channel selection

[ Mode

Module CH Sensor

Current value

First measure the cavity length of your sensor while keeping the sensor in the air.
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*\, Evolution

System  Configuration  About

Refresh devices : 24

= [Iff| Chassis 1 Monitor | Azquisiion
=] |:|I (9FPO050 - FPI-HR-2
n Candlsdeaction [] Mode  Module CH  Sensor Current value
=
O 09FP0050 | 1  FRI-evo 10634,81055 RIU

Measurement modes
Diagnostic

Channel information

Display refresh rate

37

Because the refractive index of the air is 1 calculate the “b” value:
Do 1 divided by the Current value.
Ex:1/10634,81055 = 0.000094030824084590

Go back to the Sensors List by:
1 selecting the module to get the Configuration Module window then by
2 clicking once on the Channel line to get the Configuration Channel window then by
3 clicking on “Select from list” to get the sensor list then

4 select the Refractive index sensor which is connected to the channel being used.

5 Enter this result as a float number 9,403082E-05 in the “b” case, as shown below.
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Evolution

System  Configuraton  About
Refresh devices : 2
= [Ifffil Chassis 1_ 1 Moritor | Acquisiion |
-0 ' (SEPOD50 - FPIHR-
A o CH Sensor Current value
_ Configuration - Module 09FP0050
1 | FRlevo  10635,06836 RIU
Module
Serial number 09FPOOS0 Connectortype SC/APC
Model: FPI-HR-2 Fiber type: 62.5/125
Calibration date:  2007-05-10 09:00 Controller version:  2.1.1.0
Bios wersion Mo wersion Firmware version:  2.0.0.7
Configuration
, Fiso.Controls.SensorList - C:\Documents and Settings\All Users\Application Data\SensorList.dat
ch ‘ Low pass Software acquisition s
anne frequency (Hz) rate (Hz) =NSor - File
-1 | 1 \ 5 | FRlevo Sorna Censor
. . SFOS089 .
", Configuration - Channel 1 TRENO Serial number Type of fiber : |62.6/125 Gradient Glass |,
Sofware acaustion raie 4 Model  [FRINP-C5 Type of connector: | SC/APC -
5Hz
<-‘) Calibration date : | 3 janvier 2012 ~
oo ” e
6] & ) Save changes made to list?
Serizl number - FRlevo Cener:| 1
Phenomenon :  Refraction Label Value ‘
£l 0
Unit : |RIU v 3 Cekctiom =) b ] 9.403082E-05
_ c 0
d lo |

Click on “Apply”, “OK” and “Save changes made to list” and close the Channel configuration window
and close the Configuration module window to see displayed the measurement in Rl units.

, Evolution

System  Configuration  About

Refresh devices : (2

=] Dm Chassis 1 Maritor |Ac:quis'rti0n|
i

o1 Channel selection ] Mode Module CH Sensor Current value

oo D‘ P~ ‘09FP0050‘ 1 ‘ FRI-evo ‘ 0,99999 RIU

It is important to note that the refractive index measured by the system is not for one single wavelength as it is
usually reported in the literature, but is the refractive index averaged over the wavelength covered by the
internal light source. The light source extends from 650nm to 1000nm. As a rule of thumb, it is generally
acceptable to consider that the refractive index is measured for a central wavelength of 800nm.
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C. Configure FOT-HERO manually, and with Sensor calibration
software

Set-up:

FPI-HERO Multimeter

\

DC power supply

Resistor

Sensor & Detonator

Sensor Configuration (manually):

To access the Configured sensors list window, simply click on the Configured sensors list button
from the Configuration pull-down menu.

System | Configuration | About

= Dm System...
=2-[]

Selected module, .

Configured sensors list. ., ||

Default software acguisition rates
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. Fiso.Controls.SensorList - C:\Documents and Settings\All Users\Application Data\SensorList.dat

File

SFO5102
SFO5099
FRI-DEMO
FRI-evo

Sensor

Serial number : |HERO mA 2

| Type of fiber :

100/140 Gradiart Glass & |

Modsl : [FOT-HERG 3

| Type of connector : | ST/PC ¢} v

unt: (AU 5

Center :

b Signal polarity : 1[]
Algorithm type : | Polynomial regression | | 5

Calibration date : | 4 janvier 2012 A

Label

WValue

1

Remove ]

[ Addrew 1 ]

[ Restore ] [ Apph'11]

[ OK12H Cancel ]

L o NOU A WN R

Click on the Add new button
Enter the Serial number (ex: HERO mA)
Enter the Model (ex: FOT-HERO)
Enter the Phenomenon (Custom)
Let the Unit to A.U. (Arbitrary Unit)
Choose the Algorithm type (Polynomial regression)
Enter 1 in the case “b” (it's to read the measure in nm)
FOT-HERO sensors use 100um core fiber

. FOT-HERO sensors use ST connectors

10. Choose the Single polarity (Positive)

11. Click on Apply
12. Click on OK

1-

You will see the measure in nm like below:

System

Configuration

Refresh devices: £

About

= [l Chassis 1
CIf oszri03s

- FPI-HERQ-1

Monitor | Acquisiion |

Channel selection

[ Mode
Add —>

<— Remave

Measuremert modes

Absolte 2

Mulling

Set to

i

Diagnostic

Channel information

Displzy refresh rate

37

1 Iﬁ 08ZP1035| 1 'HERO mA

Module CH Current value

15174,303 A.U.

Sensor
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If you do not see a measurement of approximately 15500 A.U. (Arbitrary Unit) then, 1 select the
channel and 2 clicks on Absolute.
Calibration:

To calibrate your sensor to measure in current (mA):

1- Create a file in Excel
2- Enter the information like below:
A | B c D E

1 Current Response

2 Target (mA) Measured (mA) nm delta (nm) mA*mA (mA?)
3 0 =C3-5C$3 =B3*B3

4 15 =C4-5C$3 =B4*B4

5 10 =C5-5C$3 =B5*B5

6 25 =C6-5CS$3 =B6*B6

7 50 =C7-5C$3 =B7*B7

8 75 =C8-5C$3 =B8*B8

9 100 =C9-5CS$3 =B9*B9
10 125 =C10-$C$3 =B10*B10
11 150 =C11-$C$3 =B11*B11
12 175 =C12-5C$3 =B12*B12
13 200 =C13-$C$3 =B13*B13
3- For each current you put, note the current measured with the multimeter and the response

in nm give by the evolutfion software (example below):
A | B c D E

1 Current Response

2 Target (mA) Measured (mA) nm delta (nm) mA*mA (mA?)
3 0 0 15116,5 0,0 0

4 15 15 15117,4 0,9 225

5 10 10,9 15117,0 0,5 118,81

6 25 24,6 15119,1 2,6 605,16

7 50 51,8 15129,1 12,6 2683,24

8 75 79,6 15146,3 29,8 6336,16

9 100 100,5 15165,2 48,7 10100,25
10 125 126,8 15194,6 78,1 16078,24
11 150 151,6 15230,1 113,6 22982,56
12 175 176,4 15272,4 155,9 31116,96
13 200 191,5 15302,5 186,0 36672,25
4- After all your measures, create a graphic in Excel.

5- Click on the tab “Insert” and in the pull-down menu, choose “Chart”.

6- Select “XY (Scatter)” and on the right side, select “Scatter. Compares pairs of values” like

below:
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Chart Wizard - Step 1 of 4 - Chart Type

Standard Types | Custom Types I

Chart type: Chart sub-type:

@ Doughnuk
iy Radar
@ Surface
®: Bubble
i Stock ﬂ
Scatter, Compares pairs of walues,
Press and Hold ta Wew Sample |
Cancel ‘ Mext = Einish |

7- Then, click on “Next”.

8- Onthe tab “Series”.

9- Forthe “Xvalues”, select the column “delta (nm).

10- For the “Y values”, select the column “mA*mA (mA?)”” and click on “Next”.

11- In the tab “Titles”, complete it with the “Chart title”, the “Category (X) axis” and the “Value
(Y) axis”, then, click on “Next”, choose where you put your chart and click on “Finish”.

Do a right click on one point and select “Add Trendline”.

On the “Type” tab, choose “Linear”.

12
13

Add Trendline

Tvpe Options
Trend/Reagression bype

|

Linear Logarithmic Polyromial
Pawer Exponential Mowing Average

Based on series:
HP

(0] ] [ Cancel

14- On the “Options” tab, check “Display equation on chart” and click OK.
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Add Trendline

Twpe Cptions |

Trendline name
(¥ Aubomaticc  Linear (HP)

() Custom:

Forecast
Forward: 0 {ﬂ Uniks
Backward: 1] {ﬂ Uniks

[] 5t intercept = 0
Display equation on chart:
[] pisplay R-squared walue on chart

(6.4

I [ Cancel
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FISO Sensor response to applied current to the bridgewire

P

Al B Sl et Tl

15- You will have something like the chart below:

40000

evolution

35000 F----nmnmmn-
000
000 4-----mmm---
000 d--cnmenenns
000 4-----mam---
10000 F----mnamnn--
000 4-------m---

(=] [Ty) (=] y) o
o () (8] —

(yw , yw) waung aapwabpug jo auenbg

2000

180,0

160,0

21)

’

1400

mA

Current (Y)
SQRT(198,26*A3+207,

1200

1000

80,0
Response from FISO Sensor (nm)

60,0
Response (X)
nm

40,0

20,0

0.0

17- When you take a measure (nm), just put in the cell A3 (in this example) and you will obtain
the current.

16- Return in your Excel sheet and do a table like below:
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Sensor Configuration (with Sensor Calibration Software):

***please contact the technical support (support@fiso.com) to download this software***

1- Like the evolution software, you need to connect your FPI-HERO into the “System
configuration” menu.

f A System Configuration @1
List of port: = COM2 -84+ X
Detected modules Selected modules
----- CoM2 [=)- Chassis 1 Erter name
08P 1036 - FP-HERO-1
2- After, you select the channel and click on “Add channel”.
SR /| Chassis 1
EID 3| 09ZP1036 - FPI-HE
I ol
| Add channels |
3- Select the module and click on “Edit sensor”’.
Channel operations
Module Channel
St someor 09ZP1036 1

4- Click on “Edit sensor” in the window.
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F ™
Edit Sensor u
Edit current
Select from list
5- Create the sensor (current)
[ & Sersor Configuration w
Senaor
Sevial rusmber : Currert 1 Type cf fiber : [62.5/125 Grociart Glass v |
Model : FOTHERD 2 Type of connector : [SC/APC -
Calbration date © 2012-04-20 -

Phasncmencn - | Cument - 3
Aigorthm typs - | S poly. egredson - 4 Lew pass flter fraqueancy
]

et :[m i Signal polaty - | -/ 6

1 Hz

[ Conter Min calbration range © -3.402827
Lahal Walie Maxx calbration range - 3202823
a 1] Window ongin - 0
b D
[+ 1] 5 )
d o LUse edendad values
L o .

6-

Enter the Serial number (ex: Current)

Enter the Model (ex: FOT-HERO)

Enter the Phenomenon (Current)

Choose the Algorithm type (Sqrt poly. regression)
Enter 1 in the case “b” (it’s to read the measure in nm)
Choose the Single polarity (Positive)

Click on Apply

Click on Close

O NOUEWNR

Click on “Start calibration”.

Start calibration
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7-

Configure the “Settings”.

evolution

[ A Settings

Sawe file location :

Mumber of measurements to average :  [[I 2
Polyromial order - |3 - 3
Agorthmtype © | Sapt poly. regression * 4

Write in smar sersor

D:\Temp 1 [ Browse .. |

5L 9% J

8-

Choose the save file location.
Enter the “Number of measurements to average”.
Enter the “Polynomial order”.

vk wnN e

Click on OK.

Click on “Proceed”.

Choose the “Algorithm type’’: Sqrt. Poly. Regression for Current.

A Warning! Iﬁ

/N WARNING A\

All the sensors displayed in the right panel will be recalibrated.
Please make sure all these sensors are propery corfigured as this
information will be used to perform the measurements.

The actual calibration information of these sensors will be saved in
the "Save file location” path specified in the previous pop-up
window.

Pleaze make sure to back up it propery as this is the anby way to
retrieve the original calibration data.

The "Write in smart sensor” option of the previous pop-up window
overavrites the actual information in smart sensors.

The saved file might be again the only way to recover the original
calibration.

For accurate results, the measured phenomenon must be kept stable
uritil all the measurements are completed.

Proceed ][ Cancel

9-

10- When you finished to take all your points, click on “Stop calibration”.

Put the sensor at the current that you want and click on “Accept value” (wait for

stabilization).

11- A window appears to confirm the success of the calibration, click on “OK".

4
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12- The new calibration is saved in the directory you chose before.

13- Close the Sensor calibration software and return in the evolution software.

14- Go to Configured sensors list window (simply click on the Configured sensors list button
from the Configuration pull-down menu).

15- On the “Configure sensors list” window, click on “File”’, “Open’’ and open the calibration file
you saved (Sensor list new calibration.dat).

A Fiso.Controls.Sensorlist

File

Open...

Save

Save as.

Quvrir E]

Regarder dans : | |9 Sensor calibration 2008-11-06 03-15-35 V| @ ? % [~

Ty Sensor list backup before calibration. dat
2} Sensor list new calibration.dat

Mes documents

Poste de travail

T
/

Mom du fichier : |Sensnr|ist new calibration.dat V| [ Quvrir l

Favoris réseau | Fichiers de type : | Sensor list files (* dat) R | [ Annuler ]

16- It imports the new calibration.
17- After, you will measure directly in mA (current).
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D. Remote control for evolution

The conditioners can be remotely controlled via a PC computer by using a RS-232 serial
communication link. It can be done with the evolution™ software which provides an effective and
simple tool for remotely controlling your conditioner as well as for downloading and viewing in real-
time the data measurements directly from your PC computer.

1.1 PRINCIPLE OF REMOTE CONTROL COMMANDS

The Remote Controls Commands allow the user to emulate from a PC computer all the control panel
functions of the conditioner and more. All the Remote Control Commands are made of ASCII type
characters, which can be sent to through the RS-232 link by using simple communication software
(such as HyperTerminal on Windows 95® or higher version). These commands can also be used
with programs made with VISUAL BASIC, VISUAL C/C++ compilers, or with third party software such
as LAB-VIEW® or LAB-WINDOWS®. With the aid of these commands, the user can create its own
remote control software.

All Remote Control Commands begin with a two capital letter identifier referred to as the prefix of
that command. Commands without argument are composed solely of their prefix. All commands
must start with a left bracket ( [ ) and end with a right bracket (] ) to be interpreted correctly. These
two characters are the delimiters of a command. Everything typed inside the brackets is considered
part of the command. Whenever a command must be followed by an argument, the command
prefix and the argument are strung together. A command is not interpreted by the conditioner until
the right delimiter is encountered in the incoming flow of characters. Each line of characters
returned to the computer by the conditioner terminates with carriage return (\r) and a line feed (\n)
character. Note also that each string of characters on same line is normally separated by a tab (\t)
character or sometime by a space character identified by the @ character in this manual. Example:
The command [SN] return the serial number of the conditioner. Upon reception of the command,
the conditioner returns the following over the serial link:

Ex: 07ZA02201\r\n

Done\r\n
1.2 SETTINGS

Before proceeding, you will need to change your HyperTerminal ACSII settings.
Set the ASCII settings, like the picture below:

— ASCIl Sending

¥ Send line ends with line feeds
¥ Echo typed characters locally

Line delay: |25| miliseconds.

Character delay: ID milliseconds.

— ASCIl Receiving
¥ Append line feeds to incoming line ends
[~ Force incoming data to 7-hit ASCII

¥ Wrap lines that exceed terminal width

OK I Cancel
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The RS-232 connection to the conditioner is made with the terminal block connector located on the
conditioner. If your computer is equipped with a DB-9 serial port connector, then use a standard RS-
232 extension cable and connect as follow:

Terminal block

Rx 3
Tx 2
GND 5

If your computer is equipped with a DB-25 connector, use a DB-25 to DB-9 converter module with a
standard RS-232 extension cable. NOTE: do not use a null modem cable or adapter.

The serial link must be configured as follow:

RS-232 port settings

BAUD PER SECOND: 115 200
DATA BITS: 8
PARITY: Odd
STOP BIT: 1
FLOW CONTROL: NONE

RS-485 port settings

BAUD PER SECOND: 921 600
DATA BITS: 8
PARITY: NONE
STOP BIT: 1
FLOW CONTROL: NONE
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E. Commands for the evolution for the FPI-HR and FPI-HERO

AS

***For the other FPI products, see the DOC-00199 on the CD***

Set or get the gage factor. (7 digits format only)

[AS] Return the gage factor if it’s in the 7 digits format. Else, return Bad Gage Factor type.
[ASxxxxxxx] | Where xxxxxxx is the sensor calibration factor.
AV

Set or get the analog output span.

[AV] Return the analog output span.
[AVX.X] Where x.x is the analog output span to set.
AZ

Set or get the analog output zero.

[AZ] Return the analog output zero.
[AZx.X] Where x.x is the analog output zero to set.
(&)

Set active channel(s) for remote commands execution.

[CS x] Channel(s) selection.
Where:
x =0 : Both channels,
x=1:Channel 1 only,
x =2 : Channel 2 only.
[CS E] Enable the display of the channel identification at the beginning of each command
output. (Example. “Channel 1:”)
[CS D] Disable the display of the channel at the beginning of each command output.
DR

Get sensor diagnostic.

[DR]

Return the sensor diagnostic.

4
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GR

Get sensor readings.

[GR 2 x] Return the x next sensor readings. If x is 0, the module returns infinitely the sensor
readings. [XX] Shall be used to stop the command.

RS

Hardware reset.

[RS] Issued a hardware reset.

SN

Get the module serial number.

[SN] Return the module serial number.

SP

Sensor configuration.

[SP N] Return the sensor serial number.

[SPy] Get the calibration coefficient y. Valid values for y are A to E.

[SPy xx.xx] | Set the y coefficient with xx.xx value. Valid y values are Ato E.

[SP S] Get the EEPROM model if available.

VB

Get the board version.

[SN] Return the board version.

VR

Get the firmware version.

[VR1] Return the firmware version.

XX

Stop acquisition.

[XX] This function stops all acquisition.
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F. Update firmware all FPI modules

***To obtain the Firmware Uploader software and the latest version of the firmware, please contact

the FISO technical support***

1- Install Firmware Uploader
2- When it installed, open it.

A, Firmware Uploader ‘}

File Network Com Help

Uploading

Com: COM29 | Baud Rate: 921600 | Parity : None

3- Gotothe Com tab and select Setup.
F
-&, Firmware Uploader
File  Metwork Help
¥ Open  Ctrl+Maj+0
Close  Ctrl+Maj+C
Upload  Ctrl+Maj+L
|"~ Setup,,  Ctrl+Maj+5
Outpul/tg‘
Firmware T
4- Choose your COM port and configure the properties of the COM like below and click OK:

P

Com Setup ; [&J1

Port Data Bits

(com2s ~| [8 -
Baud Rate Stop Bits

921600 ~| [one -
Parity Handshake

[None '] [None ']

A




evolution User Guide

5- Return in the COM tab and click on Open.

-
ﬁ* Firmware Uploader

File  Metwork | Com | Help

|g'§ Open | Ctrl+Maj+0
Close 8 Cirl+Maj+C

dp (@ Upload Ctrl+Maj+U

o Setup Ctrl+Maj+S

Output
Firmware T

6- Select Firmware.

A, Firmware Uploader

File Network Com Help

£

7- For FPI-HR/HERO ONLY, CHECK “Raw” option and for other type of FPI modules, do not
check “Raw” option.

A, Firmware Uploader

File Network Com Help

Firmware |0

C:\prod\Project\FPI-HR\Firmware\Update\Fin

Uploading
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8- Click on the folder icon and open the *.he3 file that we sent you.

-.,%_? Scan Network
)|

09ZP1033 - N/A-1.1.0.0 - N/A

| Com: COM29 | Baud Rate : 921600 | Parity : Nane

9- Click on the magnifying glass icon to scan the network for module(s).

~ Scan Network
L

Scan the Metwork for Device
D9ZP 1033 - NAA- 1.1.0.0 - NAA

8

| om: COM29 | Baud Rate: 921600 | Parity : None

10- When the software finds your module, check it.

?&3. Scan Network
)|

k[IQZF“H]?B -N/A-1.1.00-N/A

.8

| Com : COM29 | Baud Rate: 921600 | Parity : None




evolution User Guide

11- Then, click on the earth icon to update firmware.

:Z# 3 Scan Network
Ul

0957P1033- N/A-1.1.0.0- N/A

[ To Upload the new Firmware
| Com : COM29 | Baud Rate : 921600 | Parity : None

12- The software starts to update firmware.

A, Firmware Uploader e ——

File Network Com Help

~- Scan Network

%
09ZP1033-N/A-1.1.00-N/A
Firmware Ra 4
C:\prod\Project\FPI-HR\Fimware\Update\Fimware he3 \/
Uploading : 09ZP1033 - N/A - 1.1.0.0 - N/A
- = (52
i Com : COM29 | Baud Rate : 921600 | Parity : None

13- When it’s finished, your receive the message below:

. =

Firmware Upload Status

0SZFP1033 : Success




